Contents

1. Basic knowledge .................................................................................................................. 1
   1.1 Start CADbro ..................................................................................................................... 1
   1.2 Interface introduction ......................................................................................................... 1
   1.3 License activation ............................................................................................................... 2
   1.4 Open a new file ............................................................................................................... 3
   1.5 File Browser .................................................................................................................... 4

2. Manager ............................................................................................................................. 1
   2.1 Part Browser .................................................................................................................... 1
   2.2 Assembly manager ......................................................................................................... 1
   2.3 View manager ................................................................................................................ 2
   2.4 Visual manager ............................................................................................................. 3
   2.5 Export manager ............................................................................................................ 3

3. Covert files .......................................................................................................................... 5

4. View ..................................................................................................................................... 8
   4.1 View Angle .................................................................................................................... 8
   4.2 View ................................................................................................................................ 9
   4.3 Visibility ...................................................................................................................... 9
   4.4 Display Mode ............................................................................................................... 9
   4.5 Screen .......................................................................................................................... 10
   4.6 Windows .................................................................................................................... 10

5. Selection ................................................................................................................................ 12

6. Tools ..................................................................................................................................... 13
   6.1 Curve creating ............................................................................................................. 13
   6.2 Attribute ...................................................................................................................... 13
   6.3 Section ........................................................................................................................ 14
   6.4 Capture ...................................................................................................................... 17
   6.5 Assist ........................................................................................................................... 18

7. Analyze ............................................................................................................................... 20
   7.1 Measure ...................................................................................................................... 20
   7.2 Inspect Entity ............................................................................................................. 21
   7.3 Inspect Model ............................................................................................................. 23

8. PMI ...................................................................................................................................... 25
   8.1 Manager ...................................................................................................................... 25
   8.2 Dimension ................................................................................................................... 25
   8.3 Annotation .................................................................................................................. 26
   8.4 Text ................................................................................................................................ 26
   8.5 Tools .......................................................................................................................... 26

9. Healing .................................................................................................................................. 28
   9.1 Checking ...................................................................................................................... 28
   9.2 Healing ....................................................................................................................... 29

10. Editing .................................................................................................................................. 31
    10.1 Direct Edit .................................................................................................................. 31
10.2 Shape transform .................................................................................................................. 33
10.3 Part transform .................................................................................................................... 33
11. Pro ........................................................................................................................................ 34
  11.1 Assembly ............................................................................................................................. 34
  11.2 Animation ............................................................................................................................ 34
  11.3 Mold .................................................................................................................................. 36
12. Filter ...................................................................................................................................... 38
13. Interface customization .......................................................................................................... 39
1. Basic knowledge

1.1 Start CADbro

Click the CADbro icon from the desktop

Or Start-> Program->CADbro

The interface below when you first start CADbro

1.2 Interface introduction

1. Function area
2. File list
3. Quick tool bar
4. Manager area
5. Filter toolbar

6. File Browser

1.3 License activation

CADbro support stand-alone and network license activation.
1.4 Open a new file

File-> Open
1.5 File Browser

Using the File Browser, can quick locate the directory and add your frequently-used folder to as Favorites.

List windows can list different file format and quick search the specify file by name.

1-> Favorites and Recent files
2-> Disk directory
3-> File list windows
Chapter 1 Basic Knowledge
2. Manager

2.1 Part Browser

Part Browser used to list all the entity belong to the part, like solid, surface, wireframe and so on, you can uncheck the checkbox to hide the entity or right click the folder to erase, hide or show all.

![Part Browser Screenshot]

2.2 Assembly manager

Assembly manager used to manage the whole assembled structure, all the sub assembly, components can be list here, when right click on the specify component, more functions will be support.

![Assembly Manager Screenshot]
2.3 **View manager**

View manager use to manager all the view angle, section view, custom view and also the PMI.
2.4 **Visual manager**

Visual manager used to customize the display status, like open the shadow, switch on/off the coordinate or datum plane, setting up the open edge on/off, even the color or thickness.

![Visual manager settings](image)

2.5 **Export manager**

Export manager support to redefine your exporting configuration, like exporting the file format to specify folder, it can be saved as configuration, after that, you can put current 3d model from graphic window to run this task.
3. Convert files

Open: Open all the supported files in CADbro, including Z3D file.

Import: Import all other file into current Z3D. It will not go to create a new Z3D file.

Quick View: Quick import all file below in a new Z3D file with only display data, this kind of importing is faster than normal importing, but there is no Nurbs data on it. Means limited editing on such imported model.

Save: Direct save current Z3D file.

Save as: Except saving current Z3D file, you can save the whole file to any other files.
**Export:** Compare to **Save as, Export** command support to select specify shape or component from current file to export. Even can make filter to include or exclude by Layer, Geometry type and Attribute.

**Multi-Export:** Using the default exporting setting to export current opened file in the graphic window to multiple file format in one time.
4. View

3.1 View Angle

Click different View icon to change the view angle

Align with Plane:
Click this command then select one plane, the view will change to auto align this plane

Align with Direction:
Define the origin point, Up direction and Right direction to customize the view angle

How to save the View angle and reuse it later?
Click the View manager, then right click the Custom View -> New, then you can save current view angle
3.2 View

Analyse: Display the previous face analyse status

Combination: This display mode is used for assemblies when you want to display components in different display modes. Like the assembly model below, each component can shows in different display modes.
Note: To set different component to different display modes, you can right click the component >Display>then select your needed display mode.

3.5 Screen

Display multi window screen, each window size can be drag to change the size.

3.6 Windows
The list method for all open files.
5. Selection

**Pick control:** Control the input field, picking or unpicking. You can also call the pick control by right mouse button click on the graphic window.

![Pick control options](image)

**Pick Rule:** Control the picking behavior

- **Normal Pick** is the default picking behavior, which means when you Left mouse click the entity, it will auto selected but the previous picking entity will be removed, you can hold Ctrl key to achieve Add picking or unpicking.
- **Add Pick** means always add the selected entity to the input field by clicking left mouse button.
- **Del Pick** means always remove the selected entity by clicking left mouse button.

**Pick Scope:** The window pick behavior, for example, it means all the entity in the windows frame will be selected.
6. Tools

5.1 Curve creating

CADbro offers curve creating tools to create the wireframe that includes the Line, Polyline, Circle, Rectangle and so on.

![Curve tools](Image)

5.2 Attribute

**Line attribute:** Use to change the next creating curve color

**Face attribute:** Use to change the face color, or you can select face set or shape body first then click this command

For face attribute, the most often used is the Face color and Transparency

![Face attributes](Image)
You can also find the command from the Quick toolbar as below.

**Material attribute:** Use to change the shape or part materials, which allow you select the existed material from the list or add your new material.

![Material attribute](image)

### 5.3 Section

**Planar Section:**

Use this command to dynamically section the active part or assembly. Completing this command will create section curves in the active part and the active component in an assembly. It can also be used as a visual aid to dynamically clip away portions of the part to view features that might normally be hidden from view.
The required inputs include the section plane and offset distance. Optional inputs include multiple sections (copies at distance intervals) and using the section plane as the first copy.

**Section:**

**Required**

This command allows you to set specific characteristics of the section view that is enabled when Section View Display Mode is activated.

![Diagram of section view settings]

**Display control**

**Sectioned shape** - support two button, one is default option to hide the sectioned part, another button to show the sectioned part with wireframe.

**Interference** - support to specify the interference color.

**Hatch color** - allow to use part color or specify a color for the hatch.

**Hatch style** - support three button here, the first one is the switch off, the second and third one are the different hatch style.

**Spacing** - is offset value of the hatch style

**Opaque** - can drag the slider to change the transparence percent of the hatch
Orient view to plane - can align current model to the front view

Display Interference - Switch on/off the interference checking for the section view

Display section planes - Switch on/off the section plane

Display hatch for non-closed shapes - Whether creating the hatch for the open surface, that's not a perfect solid with gap or missing face

Move handle only - Only moving the dynamic moving handle when dragging, that will not move the section plane position.

Section Curve

CADbro support to display the section curves with extra window, working on the extra window, you can rotate the section profile even export it to DWG/IGES and STEPS.
Section on/off: Switch on/off the section display mode

5.4 Capture

Capture:
Use this command to capture the active display to a file. It automatically turns off the view extents readout, the world axis triad and the default datum display. You can save to bmp, gif, jpg, and tif graphics file formats. It also allows up to the maximum pixel resolution supported by your graphics card.

Screenshot:

This command will use window pick to select the area to capture, which can be store at the clipboard so that you can paste to any other application like Word or Excel, what’s more, you can save to file or choose different background color.
5.5 Assist

Datum
Use this command to insert a new datum plane, which can be used to create 3d curve or used to be section plane.

Frame
Frame can be used to create local frame, which can be used to recalculate the coordinate dimension,
**Stock**
Use this command to create an extruded stock feature that completely encloses a single face, an entire shape or a block. The required inputs include the shape(s) to enclose and a reference plane to orient the stock. By default, the size of the stock equals the extents of the shape.

**Bounding**
Use this command to create an extruded stock wireframe with PMI linear dimension.
Chapter 7: Analyze

6.1 Measure

**Distance:**

This command measures 3D distances at the Part Level. You can measure between points, geometry and planes. Remember that you can select more input options. Refer to each method and options below.

**Angle:**

This command measures 3D angles at the Part Level. You can measure between points, geometry and planes. You can select from a variety of different geometry types to measure from. Using the RMB (right mouse button) provides even more options to choose from.

**Arc:**

Use this command to select points and display arc data such as radius, included angle, center, and normal. You can use this command to check the radius of a 3D arc, curve or edge as shown in the figure or to check the theoretical arc data for three random points.
Length:
Use this command to inquire the length of a line, arc, curve, or edge. You can also inquire a length summation by selecting multiple items to measure. In the sketch, the external curves can be captured to inquire.

1) Select a line, arc, curve, or edge to measure. The length appears in the Current Curve field.
2) Select another line, arc, curve, or edge or move. Move the cursor over additional items. The new length and total length for each is displayed in the Last Curve and Summation fields.
3) Pick OK to close the form.

Area:
Use this command to inquire the area of an enclosed planar 3D or 2D region. The following information is displayed in the Inquire Area Properties Form (shown below). Refer to the 3D and 2D procedures below.

3D Surface:
Use this command to inquire an arbitrary 3D planar area enclosed by boundary curves. The boundary curves may consist of 3D/2D curves, partial or whole sketch and/or trace profiles, edges or curve lists. All boundary geometry must lie on the same plane.

6.2 Inspect Entity

Entity Info:
Use this command to displays of information about an entity in the Entity Browser. See below for additional information about using this form. This command can also be invoked automatically from the object editor by right-clicking on a highlighted entity and selecting Inquire from the popup menu.

1. Select the entity to inquire or middle-click for the target object.
2. Pick Cancel to close the Entity Browser.

Coordinate:
Use this command to display the location of a point measured in specific X,Y, Z coordinates.
Curve Info

Use this command to inquire curve information on any line, arc, curve, or edge.

NURBS data

Use this command to inquire the NURBS data of a line, arc, curve, or edge.

Control Polygon

Use this command to display the control polygon of a curve. This refers to the line segments that connect adjacent control points of a curve. The control points are the set of points that are saved by the system and used mathematically to define the curve. You can apply this command to the active part to another component in an assembly or sub-assembly from the active part.

Curvature Plot

Use this command to display the curvature plot of curves or edges. The plot is displayed as line segments projecting out perpendicular from the curves. The length of each line segment illustrates curvature at that point on the curve. This command helps to visualize overall curvature across a curve or edge.

Inquire Curve Parameter Space

Use this command to display the parameter space of a curve. Point markers at each point on a curve associate with a knot value are displayed along with the normalized parameter and arc length values at each point. This helps you determine how close the curve is to arc length parameterization. This echo relates to the existing curve. Use the Cubic Refit Curves command to echo this information for a resulting refitted curve. You can apply this command from the active part to another component in an assembly or sub-assembly.

Analyze Faces

Use this command to analyze faces for surface imperfections, draft angles, curvature, and other surface characteristics. The analysis results are presented in a variety of plots superimposed on the active part. This command switches the Graphics Window to Analyze display mode and leaves it in that mode when the command terminates. Use the View menu or the Toolbar’s display mode button to switch to another display mode when the analysis results are no longer needed.
Surface curvature

Use this command to inquire about the curvature of a face where it passes through a specified point. By default, the point lies on the face. You can use the **Face** option to select a different face to analyze. By default, a direction that is normal to the face through the specified point is used to "slice" the face for curvature analysis. You can also select a different direction if desired.

Continuity Error

Use this command to analyze the tangent continuity across two mating faces at a selected edge. The edge must be shared by both faces. The results displayed are the maximum and average error measured in degrees. You can also check for C0 continuity (gaps) along the edge by selecting **Position** from the **Continuity** option.

### 5.3 Inspect Model

Mass Properties

Use this command to calculate and display mass properties information (e.g., volume, area, mass, etc.) for a selected shape (open or closed), component, or the entire assembly. Blanked and/or suppressed components in an assembly will be ignored during these calculations. (Surface) Area is the only value that can reasonably be relied on for an Open Shape. A warning message is prominently displayed letting you know that you have selected an Open Shape.

Part Statistics

Use this command to display statistics about the active part including the numbers of features and file size. The part statistics will be displayed in the message window.

For example, the result can be listed as below.
**Thickness Analysis**

Use this command to analyze the thickness of parts and help users to estimate whether the design is correct.

**Check Draft**

Checks faces to determine if they meet a given draft angle based on an extract direction. Curves on the face(s) are created to indicate the region of the face that is less than the given draft angle.
8. PMI

8.1 Manager

After creating PMI note, you can go to manager as below to activate different view to create PMI, move or copy PMI from one view to another view, what’s more, you can control the PMI visibility by using manager.

8.2 Dimension

Use to create different 3d dimension types as below.
8.3 Annotation

Use to add different 3D annotation on the model.

---

8.4 Text

Simple text and the text with balloon

---

8.5 Tools

PMI attribute

This command is used to preset all PMI attributes, including the dimension style, text style, etc.
Resize PMI

When creating PMI note, it will generate different note size base on different view, this command can reset the global PMI size to match all notes.

Regen PMI

This command use to do regeneration for PMI, if you want the PMI to be refresh or update, you can use this command to do that.
9 Healing

9.1 Checking

This command analyzes and attempts to repair abnormal conditions relating to the geometry of entities (e.g., vertex points, edge curves, UV curves, face boundaries - refer to the figures above) that defines the topology of the active part. Such conditions include gaps between face edges and coincident vertices.

Use this command to quickly check the open edges one by one. Use the arrow button to jump to the previous or next one, use Zoom To the window will zoom to the current open edge to display.

This command checks for and/or deletes tiny edges whose curve lengths are smaller than a specified tolerance and that are not required to define the topology of the active part. This command will attempt to bring the encountered conditions within the current Geometry Tolerance setting. Select the edges to check/delete or middle-click for all edges.
9.2 Healing

Sew

Sew the open edge face to be merge one

Explode

Explode the selected face set to be multiple faces.

Sew Edge's Gap

This command attempts to sew a gap that exists between two sets of face edges. After selecting the two sets of edges, CADbro will extend the two faces to try to determine curves of intersection. If intersections are found, the faces are trimmed to the new intersection curve which then becomes the new shared edges. If multiple edges are selected for each set, it is best that they form a closed loop.

If the faces will not intersect when extended, then a medial curve located between the edges is projected onto each face and then each face is trimmed. This will not close the gap but will make the two edges more closely aligned with each other. This operation is limited to working on open faces. Therefore, you must first explode the faces and then sew them. Refer to the optional Edge Cv input below.

You can also select two sets of edge curves. A check box is provided to enable this option.

Close Gaps

This command is designed mainly to handle imported geometry to attempt to sew gaps that exist between shared face edges. After selecting the edges, CADbro will extend the faces to try to determine curves of intersection. If intersections are found, the faces are trimmed to the new intersection curves which then become the new shared edges. If multiple edges are selected, it is best that they form one or more closed loops.

If the faces will not intersect when extended, then a medial curve located between the edges is projected onto each face and then each face is trimmed. This will not close the gap but will make the two edges more closely aligned with each other. This operation is limited to working on imported open faces. Therefore, do not sew the faces before using this command.
This command fills open gaps between faces. The gaps must be bordered by a closed loop of open edges. If the edges are not coplanar, a ruled face is created. If the edges are coplanar, a planar face with trim loops is created.

Use this command to reverse the normal direction of faces or shapes. Direction arrows will appear indicating the current direction of the face or shape.
10. Editing

10.1 Direct Edit

DE Move

Use these commands to move face. Various methods are supported including directions, points and frames.

Align Move Face

Use this command to align move face by using 3D constraints. The constraints include coplanar, concentric, tangent, parallel, perpendicular, at angle and symmetric.

- **Motion face**
  
  Select a face to move.

- **Stationary**
  
  Select a stationary object. The motion face will keep the specified constraint with this object.

- **Angle**
  
  This field is available if the constraint is **At angle**. Set the angle between the motion face and the stationary object.

- **Symmetry plane**
  
  This field is available if the constraint is **Symmetric**. Specify the symmetry plane between the motion face and the stationary object.

Face offset

Use this command to offset one or more faces of a shell. This command extends or trims faces as needed during the offset operation to close gaps and resolve intersections.
**DE Draft**

This command creates a draft feature about selected faces.

**DE Copy**

Use these commands to copy face. Various methods are supported including directions, points and frames.

**DE Mirror**

Use this command to mirror the selected faces.

**DE Pattern**

Use this command to pattern the selected face.

**Modify Radius**

Use this command to modify the radius of cylinder and sphere.

**Modify Holes**

Use this command to modify hole without re-generation history.
**Simplify**

Use this command to simplify a part by removing selected faces. The command will attempt to extend and reconnect faces to close the resulting gaps in the part. If the part cannot be closed properly an error message will be returned. Select the faces to remove and then middle-click to remove them.

Alternately, you can also **delete** or blank the features that contain the faces.

![Resulting Edges and Faces to Remove](image)

**10.2 Shape transform**

Shape transform commands support to move, copy mirror and scale the selected shapes.

**10.3 Part transform**

Part transform commands support to move, drag and rotate the selected component. Compare to shape transform, the target entity type is different. One for shape, one for component.
11. Pro

11.1 Assembly

Interference check

CADbro provides many tools to work with components within an assembly. You can check for interference, blank a component or inquire component properties. You can also set the regen status of each component individually and clone parts. Refer to the topics below.

Compare parts

Use this command to compare two parts and show the differences between them. The parts have to be inserted one on top of the other as components in an empty assembly (i.e., they must occupy the same space).

If they are miss-matched more than the default geometry tolerance, the component’s faces will not be paired for the comparison. The command is not logged to the history. It is strictly a query function with no variables created.

Exploded View

Use this command to create exploded views for each assembly configuration. This command provides a list to record every explosion step, which you can re-order the existing steps by drag-dropping the picked step.

Exploded view video

Use this command to convert the picked exploded view from the lists to generate an AVI video.

11.2 Animation
Creating animated assemblies with CADbro begins with the animation object. An animation object is a target object that is owned by the assembly. There is no access to the animation outside of the assembly.

When an animation is created, a "snapshot copy" of the relevant entities in the assembly is made. From that point on, changes to the assembly are not reflected in the animation and changes in the animation are not reflected in the assembly. Changes to the component parts, however, will still be reflected in both the assembly and the animation.

Alignments, wireframe geometry, datum planes, light sources and many other entities can be created and edited within the animation. All of these edits are local to the animation. This allows a mechanism to be designed as an assembly with a degree of freedom left. Within the animation, a "driver" constraint can be added and animated without affecting constraints in the actual assembly.

**Edit Animation**
Select one of existed animation to be edited

**Animation example**
You can create simple or complex animations with or without the use of a camera. Using a camera, you can animate the viewpoint of the animation. This allows the creation of "fly-through" animations by changing the camera location at desired keyframes in the animation. Shown below are two simple animations created with and without a camera.
**Delete Animation**

Use this command to delete an existing ZW3D animation.

**11.3 Mold**

**Draft**

Use this command to analyze faces for surface imperfections, draft angles, curvature, and other surface characteristics. (See Chapter 5.2 Inspect Entity-> Analyze Faces)

**Project Silhouette curve to plane**

Use this command to project the shape silhouette to a plane. You can control to display the outer loop of silhouette only or all curves of it.

**Thickness Analysis**

Use this command to analyze the thickness of parts and help users to estimate whether the design is correct.
**Align**
This feature is used to realign geometry after data is imported. Click to enter the interface.

**Shrink**
This command is used to define product's shrinkage.

**Region**
The command according to the regularity of mold structure can quickly review all the surface properties of the model. In Auto Define, selecting a product model and determine the opening mold direction (default is z axis). System will automatically analyze and get different colors according to different parts of a mold, which distinguishes between core and cavity easily. System goes into Manual Define when completing automatically. User can view the analysis results under regional options. In this interface, users can change their mold structure to satisfy the design needs so as to provide basis for future mold design. The core and cavity area have been defined when the Undefined Faces show zero.
12. Filter

Filter is important to control the select entity from the graphic window.

The pick filter list shows the entity types that the active command prompt is looking for. The list is displayed when the pick filter icon is selected (see above) or when (Shift) key and the right mouse button (RMB) are selected together. When you select an entity type from the list, only those entities can be selected or highlighted. You can pick the Attributes button (when displayed) to filter by additional attributes.

Holding the Shift key + Right mouse button, the filter list will display on your mouse pointer position.
13. Interface customization

You can right mouse button click on the ribbon empty area, then you can see interface customization command. Or you can directly click the Customize... command from the Ribbon tab.

What you can customize?

You can add your own command.
Transfer the command between different ribbon tab, you can also create a new ribbon tab.

Customize the hotkey for CADbro.
Customize your mouse action, with this function below, you can customize CADbro mouse actions to be the same as other 3D system, this will make you easy to get used to work with CADbro.

![Customize Mouse Actions](image)

<table>
<thead>
<tr>
<th>Function Key</th>
<th>Mouse Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Null</td>
<td>Middle Mouse Button</td>
</tr>
<tr>
<td>Null</td>
<td>Right Mouse Button</td>
</tr>
<tr>
<td>Ctrl</td>
<td>Middle Mouse Button</td>
</tr>
</tbody>
</table>

[Diagram of Customize Mouse Actions]

[Default button]